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САМ СЕБЕ 
ПЛОТНИК

Фотомонтаж. Именно это слово приходит на ум, когда в газетах 
появляется новое сообщение об НЛО с иллюстрирующими его 
фотографиями. Скептики сразу начинают обсуждать увиденное, 
выдвигая множество объяснений, почему эти снимки могут быть 
подделкой.

Андрей Турцевич
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ФОТОМОНТАЖ В ADOBE PHOTOSHOP

В действительности приемы обработ
ки изображений, иногда используемые для 
фальсификации данных, широко применяют
ся в работе профессиональных фотохудож
ников для реализации творческих замыслов. 
Будь то книжная иллюстрация, художествен
ный фильм или рекламный блок – часто имен
но с помощью компьютерной обработки их со
здатели добиваются нужного эффекта. При
чем если монтаж выполнен профессионально, 
большинство зрителей редко догадываются 
о том, что фото или видео ненастоящее. Про
граммы, используемые для обработки снимков 
и иллюстраций, называются графическими ре
дакторами, и наиболее популярным из них яв

ляется Adobe Photoshop. Этот пакет стоит «на 
вооружении» как голливудских киностудий, 
так и дизайнерских бюро по всему миру. Спра
ведливости ради необходимо отметить, что 
Photoshop далеко не единственная отличная 
программа для обработки изображений, од
нако поскольку стандарты Adobe стали свое
образным языком общения компьютерных ди
зайнеров, наш урок будет проводиться именно 
в этой программе. Причем для демонстрации 
приемов фотомонтажа мы используем новый 
Adobe Photoshop CS.

В этом уроке мы компьютерными средствами 
постараемся создать реалистичное изображе
ние, имитирующее фото разноцветных коттед

жей, часто украшающих океанское побережье 
в теплых странах.

Для изучения урока вам необходим базо
вый уровень знаний программы. Чтобы было 
легче повторить приведенную последователь
ность действий, убедитесь в том, что настрой
ки панелей в Photoshop соответствуют задан
ным по умолчанию. Для этого выберите в меню 
Window → Workspace → Reset Palette Locations. 
В старых версиях программы это можно сделать 
из меню File → Preferences → General… выбрав 
команду Reset Palette Locations to Default. Для 
того чтобы правильно обработать приведенное 
исходное изображение, вам понадобятся также 
знания основ линейной перспективы.

Поворачиваем
Изза неточного кадрирования изображенный на сним

ке дом несколько завален набок. Исправить этот недоста
ток можно следующим образом: добавляем вертикальные 
и горизонтальные направляющие, стянув их с линеек, за
тем, выделив кадр  (Ctrl + А) и перейдя в режим свободной 
деформации (Ctrl + Т), поворачиваем снимок так, чтобы тор
цы постройки стали параллельны направляющим.

Выделяем
Вначале обводим контуры дома, нарисовав кривую с 

помощью инструмента Pen, затем уточняем положение 
огибающей, используя Direct Selection Tool. Остается толь
ко преобразовать кривую в выделение – для этого, пе
рейдя на вкладку Path и удерживая нажатой клавишу Ctrl, 
щелкаем указателем мыши по пиктограмме Work Path. Те
перь можно вырезать объект.

Убираем фон
Используя меню Layer, выбираем New → Layer via Copy, 

создаем отдельный слой из области снимка, ограниченной 
выделением. Сделаем исходный снимок невидимым, щелк
нув мышью по изображению глаза на слое Background. За
тем для удобства дальнейшей работы увеличиваем размер 
рабочей области – инструментом Crop очерчиваем новую 
границу снимка и нажимаем Enter.

Выделяем фрагмент неба
Включаем видимость слоя Background, очертив пря�

моугольник вокруг однотонного участка неба на фото
снимке, переходим на этот слой и создаем новый, копи
руя выделение. Это можно сделать, как и на предыдущем 
этапе – с помощью меню или же используя «горячую» 
комбинацию клавиш Ctrl + J. Затем создаем новый слой и 
отключаем видимость остальных.

01-04 05-08

09-12 13-14

совет

Инструмент 
Pen
Ñóùåñòâóåò íåñêîëüêî 
ñïîñîáîâ ñîçäàíèÿ 
âûäåëåíèé â Photoshop.
Îäèí èç ñàìûõ óäîáíûõ – 
ïðåäâàðèòåëüíàÿ ïðîðè-
ñîâêà âåêòîðíîãî êîíòóðà 
èíñòðóìåíòîì Pen.  Ïðå-
èìóùåñòâî èñïîëüçîâàíèÿ 
âåêòîðíîé ëèíèè çàêëþ-
÷àåòñÿ â âîçìîæíîñòè èç-
ìåíÿòü åå â äàëüíåéøåì, 
åñëè âûäåëåíèå îêàæåòñÿ 
íåòî÷íûì.
Äëÿ ïîñëåäóþùåãî èñ-
ïîëüçîâàíèÿ ñîõðàíèòå 
êðèâóþ ñ ïîìîùüþ  
êîìàíäû Save Path íà 
âêëàäêå  Path.
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Создаем новый фон
Держа нажатыми Alt+Shift, указателем мыши сдвига

ем фрагмент кадра влево таким образом, чтобы полу
чить равномерный фон вдоль всего снимка. При каждой 
такой операции Photoshop создает новый слой, автома
тически присваивая ему имя. Для того чтобы избавить
ся от большого количество отдельных элементов, «сли
ваем» их воедино, связав все слои и дав в меню вкладки 
Layers команду Merge Linked. Чтобы связать слои, доста
точно на вкладке Layers протянуть мышью вниз по полям 
связи (справа от изображений глаза), начиная со второ
го слоя сверху.

Вспомогательные линии
Для создания реалистичного изображения позже нам пот

ребуется не только размножить постройки, но и изменить их 
размеры так, чтобы появилась иллюзия перспективы. Точ
ное выполнение таких операций на отдельном слое потребу
ет вспомогательного рисунка – перспективной сетки, задаю
щей направления к точке схода и помогающей геометричес
ки определить высоту объектов на изображении. Выбираем 
линию горизонта в качестве одного из направлений и про
водим вдоль него вспомогательную линию. Точку схода нахо
дим, продлив фронтальную границу крыши до пересечения с 
линией горизонта.

Перспективная сетка
Инструмент Line в Photoshop (включается клавишей U) создает векторные объекты в виде узких пря�

моугольников, имитирующих линии определенной толщины. Мы установили две перпендикулярные на
правляющие в точке схода и задали привязку к направляющим для того, чтобы при рисовании линий 
они выходили из одной точки. Теперь начинаем разметку линиями – устанавливаем указатель мыши 
около точки пересечения и протягиваем новую линию ниже линии горизонта за пределы рабочей об
ласти с противоположной стороны от точки схода. Далее размечаем всю рабочую область, проводя ли
нии, выходящие из одной точки, так, чтобы расстояние между их концами по вертикали было примерно 
одинаковым. Полученную перспективную сетку преобразуем в выделение и закрашиваем.

15-16 17-18

19-23

совет
Прозрачность
слоя

Íîâîìó ñëîþ ñ íàáî-
ðîì ëèíèé æåëàòåëü-
íî äàòü íàçâàíèå, äëÿ 
òîãî ÷òîáû â äàëüíåé-
øåì åãî ëåãêî áûëî íàõî-
äèòü â ñïèñêå (ìû íàçâà-
ëè ñëîé Perspective Grid).
Äëÿ óäîáñòâà ñîçäàííîå èç 
âåêòîðíûõ îáúåêòîâ ðàñ-
òðîâîå èçîáðàæåíèå ïåð-
ñïåêòèâíîé ñåòêè ìîæ-
íî ñäåëàòü ïîëóïðîçðà÷-
íûì. Äëÿ ýòîãî ïåðåéäè-
òå íà ñëîé Perspective Grid 
(âêëàäêà Layers)  è ðåãóëÿ-
òîðîì Opacity óñòàíîâèòå 
çíà÷åíèå 65%.

совет
Почаще
сохраняйте
работу
Íåñìîòðÿ íà òî ÷òî â 
Adobe Photoshop CS èìå-
åòñÿ âîçìîæíîñòü ìíîãî-
êðàòíîé îòìåíû âûïîëíåí-
íûõ îïåðàöèé, ðåêîìåí-
äóåì ðåãóëÿðíî ñîõðàíÿòü 
ðàáî÷èé ôàéë (Ctrl+S) íà 
ñëó÷àé âîçìîæíîãî ñáîÿ â 
ðàáîòå ÏÊ.

КРУПНЫМ ПЛАНОМ: РИСОВАНИЕ ЛИНИЙ
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Начинаем менять крышу
Покроем крышу досками, используя в качестве «строи

тельного материала» фрагменты стен постройки. Выделим 
вертикальную торцевую рейку дома инструментом Polygonal 
Lasso. Скопируем ее на отдельный слой, размножим и созда
дим торцы крыши,  поставив «доски» под  углом. 

Обшиваем досками
Продолжаем обшивать крышу, используя «материал» стен. 

Боковую часть зашьем элементами из части стены под ней. 
Фронтальный элемент заполним «досками» из области воз
ле окна. Для того чтобы получить «панель» нужной ширины, 
клонируем фрагмент из нескольких досок.

Делаем дверь
Инструментом Rectangular Marquee выделяем цен

тральную часть окна и, клонируя ее вниз несколько 
раз, составляем из фрагментов «дверь». Выделяем 
верхнюю часть окна и, присоединив ее к получен
ной клонированием области, создаем новый слой 
Door.

Отделяем окно
Теперь необходимо отделить окно. Для этого обводим его 

по контуру инструментом Polygonal Lasso, переносим на от
дельный слой и «обшиваем» фронтальную стену досками. 
Для того чтобы участок, полученный клонированием, не вы
делялся по яркости, затемняем его с помощью инструмента 
Burn (включается клавишей O).

Перемещаем окно и дверь
Слои с дверью и окном смещаем таким образом, чтобы 

расположить их рядом на передней стене. При этом необ
ходимо включить слой Perspective Grid и выровнять верхние 
края окна и двери по одной из направляющих. Выделяем 
тень  от окна, переносим на отдельный слой комбинацией 
клавиш  Shift+Ctrl + J и смещаем ее. Выступающую  часть об
резаем. 

Вставляем стекло
Выделяем фрагмент окна, заделанный досками, и пере

мещаем границу горизонтально на область фона. Сохраня�
ем выделение в отдельном канале – Select → Save Selection. 
Заполняем небольшой участок фона, попадающий в обве
денный фрагмент, клонируя море инструментом Clone Stamp. 
Остается включить сохраненную границу, скопировать фраг
мент и «вставить» «стекло» в раму. 

37-40

27-36

41-45

46-49

24-26

50-55

совет

Используйте
Free Transform
Ïðè äåôîðìàöèè ýëåìåí-
òîâ óäîáåí ðåæèì ñâîáîä-
íîé äåôîðìàöèè, ïîçâîëÿ-
þùèé ìåíÿòü ôîðìó, ïðî-
ïîðöèè è ðàçìåð îáúåêòîâ 
íà ñëîÿõ èëè íà ãðóïïàõ 
ñëîåâ. Îáðàòèòå âíèìàíèå 
íà òî, ÷òî äëÿ ïðîïîðöèî-
íàëüíîé òðàíñôîðìàöèè 
íåîáõîäèìî äåðæàòü íàæà-
òîé êëàâèøó Shift.
×àñòî èìååò ñìûñë ñäå-
ëàòü òðàíñôîðìèðóåìûå 
ýëåìåíòû ïîëóïðîçðà÷-
íûìè, ÷òîáû áûëî ëåã÷å 
êîíòðîëèðîâàòü ïðåîáðà-
çîâàíèå.
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Изменяем оттенки фона
Сделаем небо на снимке насыщенносиним. Для этого ис

пользуем корректирующие слои Levels и Hue/Saturation над 
слоем Sky. Чтобы включить корректирующие слои, щелкнем 
по  пиктограмме «новый корректирующий слой» в нижней 
части вкладки Layers. 

Завершаем крышу
Слой Sky и  корректирующие слои помещаем в отдельную 

папку – набор слоев. Аналогично поступаем с изображени
ем дома и элементами его отделки, создав набор слоев House 
One. Завершаем отделку постройки, добавив недостающую 
рейку в торце крыши и обрезав выступающие фрагменты.

Табличка с номером
Создаем прямоугольное выделение на отдельном слое и 

заполняем его светлой краской (инструмент Paint Bucket). 
Затем с помощью инструмента Horizontal Type пишем номер. 
Используя вкладку Character, изменяем параметры шрифта.
Объединяем созданные  элементы в группу.

Ставим номер
Преобразовав текст в растр, выделяем группу, переходим 

в режим свободной трансформации и устанавливаем номер 
на дверь, изменяя форму номера так, чтобы верхний и ниж
ний  его торцы совпадали с направлениями  сетки и добавля�
ем реалистичную тень, используя диалог Layer Style.

Раскрашиваем
Выделяем стены постройки до крыши инструментом 

Polygonal Lasso, после чего над слоем с изображением дома 
создаем корректирующий слой Hue/Saturation, область 
действия которого ограничена выделением. В диалоговом 
окне корректирующего слоя включаем опцию Colorize и ус
танавливаем движки Hue, Saturation и Lightness в положения 
0,72 и 43 соответственно. 

Клонируем!
Собранные в группу раскрашенные элементы дома лег

ко скопировать целиком, для этого House One перетягива
ем на изображение чистого листа в нижней части вкладки 
Layers. Аналогично создаем еще одну копию дома House 
Three. Полученные «дома» необходимо сместить в гори
зонтальной плоскости и масштабировать по перспектив
ной сетке.

56-61

Набор слоев

Â âîñüìîé (CS) âåðñèè 
Adobe Photoshop èìååòñÿ 
óäîáíàÿ âîçìîæíîñòü ðà-
áîòàòü ñ ãðóïïàìè ñëîåâ, 
ò. å. îðãàíèçîâûâàòü ñëîè 
â âèäå îòäåëüíûõ íàáî-
ðîâ, êîòîðûå çàòåì ìîæ-
íî òðàíñôîðìèðîâàòü èëè 
îòêëþ÷àòü îäíîâðåìåí-
íî. Ýòî çíà÷èòåëüíî îá-
ëåã÷àåò æèçíü ïðè ïîäãî-
òîâêå ñëîæíûõ èëëþñòðà-
öèé. Äëÿ òîãî ÷òîáû ñî-
çäàòü ãðóïïó ñëîåâ â ìåíþ 
âêëàäêè Layers âûáåðè-
òå New Layer Set... Ñîçäàâ 
íîâóþ ïàïêó, ïåðåòàùèòå 
â íåå ñëîè, êîòîðûå íåîá-
õîäèìî ñãðóïïèðîâàòü.

совет

62-70

71-73 74-79

80-92 93-96

совет
Редактирование 
текста
Ïðè ðàáîòå ñ òåêñòîì 
â ãðóïïå ñëîåâ äëÿ 
âûïîëíåíèÿ òðàíñôîðìàöèè 
åãî ïðèõîäèòñÿ 
ïðåîáðàçîâûâàòü â ðàñòðîâîå 
èçîáðàæåíèå. Ñîõðàíèòå 
íåòðàíñôîðìèðîâàííûé òåêñò 
íà ñëó÷àé, åñëè â áóäóùåì 
ïîòðåáóåòñÿ ñäåëàòü åùå 
íîìåðà. 
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Изменяем перспективу
Поскольку дома расположены по направлению взгляда, масштаб их изменяется по мере уда

ления от наблюдателя. Чтобы проекция на плоскость соответствовала реальному изображе
нию, одинаковые элементы построек должны находиться на одинаковых линиях перспектив
ной сетки. На слое Perspective Grid удобно дорисовать несколько линий, проходящих через гра
ницы элементов постройки. Тогда масштабируя соседние дома, можно точно определить их 
размер. В нашем примере верхние границы крыши и торцов оконных рам всех построек нахо
дятся на одних линиях.  

Снова раскрашиваем
Новые дома перекрашиваем в другие цвета. Для этого 

нет необходимости создавать новые корректирующие 
слои – достаточно в пределах группы выделить нужный 
слой  и двойным щелчком на пиктограмме слоя вывести 
его диалоговое окно, в котором изменить значения па
раметров. При выборе цветов для раскраски мы огра
ничились четырьмя оттенками, подбирая раскраску от
дельных элементов так, чтобы постройки контрастиро
вали друг с другом.

Меняем числа
Когда мы устанавливали номер дома, текстовый блок при

шлось преобразовать в растровое изображение для того, 
чтобы можно было выполнить деформацию группы слоев. 
Номера трех домов необходимо сделать разными. Для это
го удаляем старые варианты чисел, и из сохраненных в груп
пах нетрансформированных текстовых блоков создаем но
вые надписи. Для разных номеров расстояние между сим
волами различно. Кернинг для каждой новой пары меняем, 
используя вкладку Character. 
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КРУПНЫМ ПЛАНОМ: МАСШТАБИРОВАНИЕ

98-101



102 11 I 2004 • 

 Устанавливаем номера
Новые номера устанавливаем, ориентируясь по направля�

ющим. Необходимо учитывать, что элементы, расположен
ные ближе к наблюдателю, выглядят насыщеннее и контрас
тнее. Поэтому  затемняем номера и понижаем контраст – тем 
сильнее, чем дальше номер  от наблюдателя.

Еще два дома
Прежде чем выполнить окончательное кадрирование 

изображения, добавляем еще две постройки и масштаби
руем их, включив слой Perspective Grid. Необходимо это для 
того, чтобы после обрезки кадр выглядел как фрагмент не
прерывной череды построек. 

Делаем тени
Создадим тени, которые отбрасывают впереди стоящие 

постройки на находящиеся за ними. С помощью Polygonal 
Lasso строим контуры тени на первом доме. По выделению над 
группой слоев House One помещаем корректирующий слой 
Hue/Saturation. Аналогично поступаем с остальными домами. 

Красим и кадрируем
Покрасив новые дома, выполняем окончательное кад

рирование снимка с помощью инструмента Crop. Уменьша
ем масштаб вывода на экран так, чтобы при обрезке видеть 
фрагменты, остающиеся за кадром. «Доращиваем» фон, ко
пируя его по горизонтали.

Заделываем дыры
Восстановим часть стены синего дома, используя прием, 

применявшийся при отделке крыши – выделяем часть сте
ны и смещаем ее копию так, чтобы закрыть просвет. Затем 
переключаемся на корректирующий слой, отвечающий за 
окраску стен, и инструментом Brush черного цвета увели
чиваем область действия слоя на всю стену.

Ставим крыльцо
После того как мы продлили изображение, желтая дверь 

стала выглядеть нереально высокой, поэтому, используя ра
зученные ранее приемы, «дорисуем» к ней крыльцо. Пользу
ясь перспективной сеткой и «строительным» материалом, из 
«досок» стены дома нетрудно создать как горизонтальные, 
так и вертикальные плоскости ступеней. 
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113-115

практикум
совет

Повторная
коррекция
Ïðè íåîáõîäèìîñòè 
ïðîâåäèòå îêîí÷àòåëüíóþ 
êîððåêòèðîâêó öâåòîâ è 
òîíîâ íà èçîáðàæåíèè, 
èçìåíÿÿ ïàðàìåòðû 
êîððåêòèðóþùèõ ñëîåâ 
â ãðóïïàõ. Óäîáñòâî 
èñïîëüçîâàíèÿ òàêèõ 
ñëîåâ â òîì, ÷òî ïîäîáíûå 
èçìåíåíèÿ ìîæíî 
ïðîâîäèòü ìíîãîêðàòíî, 
íå îïàñàÿñü èñïîðòèòü 
èçîáðàæåíèå.
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ФОТОМОНТАЖ В ADOBE PHOTOSHOP

Завершаем отделку
Аналогичные действия необходимо выполнить для того, 

чтобы закрыть стену дальнего дома. Продлив покрытие и за
красив его кистью Brush, на корректирующем слое добавля�
ем  участок грунта, на котором располагается дом. Для этого 
используем фрагмент исходного изображения.

Фото для фона
Подбираем подходящую фотографию облаков и откры

ваем ее в Photoshop. Выделив все изображение командой  
Ctrl + А, копируем облака и переносим их в рабочий файл. 
Важно помнить, что при копировании требования к ресур
сам ПК возрастают. 

Несмотря на простоту, показанный здесь пример не менее эф
фектен, чем те, что применяются профессионалами для получения 
реалистичных и порой самых фантастических результатов. Ключом 
к пониманию использованного подхода является девиз создателей 
Photoshop: «Если вы сможете это представить, то с помощью наше
го пакета вы сможете это сделать», намекающий не только на широ
кие возможности самой программы, но и на то, что каждый худож
ник еще до начала работы должен хорошо представлять будущий 
результат.  Благодаря яркой цветовой гамме и четко выраженной 
графичности композиции такой снимок подойдет в качестве иллюс
трации к статье, посвященной, например, путешествиям.  Мы ис
пользовали эту иллюстрацию для оформления нашей обложки.

Данный урок – не демонстрация одного определенного эффек
та, а рассказ о том, как добиться желаемого результата, используя 
возможности пакета в комплексе. Мы показали вам, как делать вы
деления и применять маски, рассмотрели принципы работы со сло
ями (в том числе с корректирующими), с группами слоев, приемы 
деформации, обрезки, раскраски и тонирования фрагментов изоб
ражения. 
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Подставляем фон
Остается изменить очередность слоев и несколько увели

чить фон, чтобы он закрывал весь кадр.  Для этого на  вклад
ке Layers перемещаем новый слой вниз так, чтобы он рас
положился над группой Sky. В режиме свободной транс
формации, держа нажатой клавишу Shift, пропорционально 
увеличиваем подложку. Несколько затемняем «новое» небо, 
создав для него корректирующий слой Levels. 

131
Последние штрихи
Иллюстрация почти готова. Сделаем изображение зер

кальносимметричным, для того чтобы при рассмотрении 
взгляд зрителя следовал от более удаленных объектов к 
ближним. Для  этого воспользуемся командой Image →
Rotate Canvas → Flip Canvas Horisontal. Остается сохранить 
полученный файл в формате Photoshop и сделать его копию 
в формате JPEG для печати и быстрого просмотра. 

132-136

совет

Преимущество
работы со 
слоями
Ïîñêîëüêó íà 
èëëþñòðàöèè, ñîñòîÿùåé 
èç ñëîåâ, ôîí îòäåëåí 
îò ïåðåäíåãî ïëàíà, 
åãî ëåãêî  çàìåíèòü 
ëþáûì èçîáðàæåíèåì.  Â 
áóäóùåì ñîñòàâëåííóþ èç 
ñëîåâ èëëþñòðàöèþ áóäåò 
âîçìîæíî âèäîèçìåíèòü, 
ñäåëàâ íîâûé âàðèàíò 
èçîáðàæåíèÿ.  Äëÿ ýòîãî 
ñîõðàíÿéòå èçîáðàæåíèå â 
ôîðìàòå *.psd

123-129




